
OSSSC CRE 2025
Combined Recruitment Examination · Preliminary · Question Paper

08 Jun 2026 · 4:00 PM - 5:30 PM Odia Version

RI · ICDS Supervisor · VAW · JA · ARI · Amin · SFS  |  Official Answer Key

About this Paper

This is the OSSSC Combined Recruitment Examination (CRE) 2025 Preliminary written test (Advt. IIE-120/2025-3219) for the posts of
Revenue Inspector, ICDS Supervisor, Village Agricultural Worker, Junior Assistant, Assistant Revenue Inspector, Amin & Statistical Field
Surveyor — 08 Jun 2026, 4:00 PM - 5:30 PM shift, Odia version, with the correct option marked as per the official answer key.

Exam pattern: 100 questions · 100 marks · 90 minutes. Sections: Mathematics 20, General Studies 20, English 20, Odia 15, Computer
15, Logical Reasoning 10. Marking: +1 correct, −0.25 wrong.

✓ Correct option (highlighted green)

More from QMaths

Check your marks & All-India rank at rank.qmaths.in. Master English vocabulary with the Blackbook app.

Toppers' Choice, Blackbook of English Vocabulary, Now available in App format : DOWNLOAD NOW

https://rank.qmaths.in/
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25


Paper Set 1 · 08 Jun 2026 · 4:00 PM - 5:30 PM · OSSSC CRE 2025 (Odia)

Quant

✓

Q1 Quant
ରମେଶ ଓ ସୁ ରେଶଙ୍କ ବୟସର ଅନୁ ପାତ 3 : 5 ଅଟେ । ଯଦି  ରମେଶଙ୍କୁ  12 ବର୍ଷ  ହୋଇଥାଏ,
ତେବେ ସୁ ରେଶଙ୍କ ବୟସ କେତେ?

A.  15 ବର୍ଷ

B.  18 ବର୍ଷ

C.  20 ବର୍ଷ

D.  22 ବର୍ଷ

✓

Q2 Quant
ଜଣେ ସାଇକେଲ ଚାଳକ 72 km ର ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ମାର୍ଗ କୁ  ଅତି କ୍ର ମ କରନ୍ତି  । ଯଦି  ତାଙ୍କର
ବେଗ 2 km/h ବୃ ଦ୍ଧି  ହୁ ଏ, ତେବେ ସେ 30 ମି ନି ଟ ପୂ ର୍ବ ରୁ  ପହଞ୍ଚନ୍ତି  । ତାଙ୍କର ପ୍ରା ରମ୍ଭି କ ବେଗ
ନି ର୍ଣ୍ଣ ୟ କର ।

A.  12 km/h

B.  14 km/h

C.  16 km/h

D.  18 km/h

✓

Q3 Quant
ଜଣେ ଦୋକାନୀ ₹15,000 ରେ 300 ଟି  ରାଇଟି ଙ୍ଗ ପ୍ୟାଡ କି ଣି ଥି ଲେ । ଦୋକାନୀ ସେଗୁ ଡ଼ି କୁ
ଲାଭ ରଖି  ବି କ୍ରି   କରି ବାକୁ  ଚାହୁଁ ଥି ଲେ, ତେଣୁ  ସେ 30 ଟି  ରାଇଟି ଙ୍ଗ ପ୍ୟାଡ ମାଗଣାରେ
ପାଇଲେ । ଏହାକୁ  କେତେ ପ୍ର ତି ଶତ ଲାଭରେ ବି କ୍ରି   କରାଯି ବା ଉଚି ତ?

A.  15%

B.  17%

C.  12%

D.  10%

✓

Q4 Quant
ଜଣେ ବ୍ୟକ୍ତି  ତାଙ୍କ ମାସି କ ଆୟର 10% ଘର ଭଡାରେ, 22% ଖାଦ୍ୟରେ ଏବଂ 23%
ପି ଲାମାନଙ୍କ ଶି କ୍ଷାରେ ଖର୍ଚ୍ଚ  କରନ୍ତି ; ତା'ପରେ ତାଙ୍କ ପାଖରେ ₹8100 ବଳକା ରହି ଲା ।
ତାଙ୍କର ମାସି କ ଆୟ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  ₹18,000

B.  ₹15,000

C.  ₹21,000

D.  ₹24,000

✓

Q5 Quant
ଦୁ ଇ ଜଣ ଅଂଶୀଦାର P ଓ Q ଏକ ବ୍ୟବସାୟରେ ଯଥାକ୍ର ମେ ₹15,000 ଓ ₹25,000
ନି ବେଶ କରନ୍ତି  । ଏକ ବର୍ଷ  ପରେ ମୋଟ ଲାଭ ₹16,000 ହୁ ଏ, ଯାହାକୁ  ସେମାନେ
ସେମାନଙ୍କର ନି ବେଶ ଅନୁ ପାତରେ ବାଣ୍ଟି  ନି ଅନ୍ତି  । ଲାଭରେ Q ଙ୍କ ଅଂଶ କେତେ?

A.  ₹9,500

B.  ₹9,800

C.  ₹10,000

D.  ₹10,200

✓

Q6 Quant
ଏକ ବସ ସହର A ରୁ  ସହର B ପର୍ଯ୍ୟ ନ୍ତ 70 km ଦୂ ରତାକୁ  30 km/h ବେଗରେ ଯାତ୍ରା
କରେ । ସେହି  ସମୟରେ, ଏକ ମୋଟରସାଇକେଲ ସହର B ରୁ  ସହର A ଅଭି ମୁ ଖେ 40
km/h ବେଗରେ ଯାତ୍ରା  ଆରମ୍ଭ କରେ । ସାକ୍ଷାତ ପରେ, ମୋଟରସାଇକେଲ ତାର ବେଗ 10
km/h କୁ  ହ୍ରା ସ କରେ ଏବଂ ସହର A ପର୍ଯ୍ୟ ନ୍ତ ଜାରି  ରଖେ । ସେମାନଙ୍କ ସାକ୍ଷାତର ଦୁ ଇ ଘଣ୍ଟା
ପରେ ସହର A ରୁ  ମୋଟରସାଇକେଲର ଦୂ ରତା କେତେ?

A.  10 km

B.  20 km

C.  25 km

D.  30 km

✓

Q7 Quant
ଗୋଟି ଏ ଟାଙ୍କି କୁ  ଏକ ପାଇପ ଦ୍ୱାରା 18 ଘଣ୍ଟାରେ ପୂ ର୍ଣ୍ଣ  କରାଯାଏ । ଅନ୍ୟ ଏକ ପାଇପ ଏହାକୁ
21 ଘଣ୍ଟାରେ ଖାଲି  କରେ । ଯଦି  ଦୁ ଇଟି  ଯାକ ପାଇପ ଏକାଠି  ଖୋଲାଯାଏ, ତେବେ ଟାଙ୍କି ଟି
କେତେ ଘଣ୍ଟାରେ ପୂ ର୍ଣ୍ଣ  ହେବ?

A.  88

B.  94

C.  112

D.  126

✓

Q8 Quant
ପ୍ର ଦତ୍ତ ସଂଖ୍ୟା ସେଟର ଗରି ଷ୍ଠକ ନି ର୍ଣ୍ଣ ୟ କର ।

63, 87, 91, 78, 89, 36, 87, 98, 78, 63, 98, 79, 89, 36, 63

A.  79

B.  98

C.  89

D.  63
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✓

Q9 Quant
ଏକ ସୁ ଷମ ବହୁ ଭୂ ଜର ସମସ୍ତ ଅନ୍ତଃସ୍ଥ କୋଣର ସମଷ୍ଟି  1620° ଅଟେ । ଏହି  ବହୁ ଭୂ ଜର
କେତୋଟି  ବାହୁ  ଅଛି ?

A.  13

B.  12

C.  11

D.  10

✓

Q10 Quant
ଯଦି  ଏକ ସଂଖ୍ୟାର 20% କୁ  54 ସହି ତ ଯୋଗ କରାଯାଏ, ତେବେ ଯୋଗଫଳ ସମାନ
ସଂଖ୍ୟା ହେବ । ସମାନ ସଂଖ୍ୟାର 80% କେତେ?

A.  54

B.  64

C.  84

D.  74

✓

Q11 Quant
ଗୋଟି ଏ ପାଇପ୍  8 ମି ନି ଟରେ ଏକ ଟାଙ୍କି କୁ  ପୂ ର୍ଣ୍ଣ  କରି ପାରି ବ ଯେତେବେଳେ ଅନ୍ୟ ଏକ
ପାଇପ ପୂ ର୍ଣ୍ଣ  ଟାଙ୍କି କୁ  32 ମି ନି ଟରେ ଖାଲି  କରି ପାରି ବ । ଯଦି  ଟାଙ୍କି ଟି  ଖାଲି  ଥି ବା ସମୟରେ
ଉଭୟ ପାଇପ ଏକାଠି  ଖୋଲାଯାଏ, ତେବେ ଟାଙ୍କି ର ତି ନି -ଚତୁ ର୍ଥାଂ ଶ ପୂ ର୍ଣ୍ଣ  ହେବାକୁ  କେତେ
ମି ନି ଟ୍  ଲାଗି ବ?

A.  8

B.  16

C.  9

D.  17

✓

Q12 Quant
₹12,123 କୁ  X, Y ଓ Z ଙ୍କ ମଧ୍ୟରେ ଏପରି  ଭାବରେ ବି ଭକ୍ତ କରାଯାଇଛି  ଯେ ଯଦି  ₹84,
₹47 ଓ ₹64 କୁ  ସେମାନଙ୍କ ଭାଗରୁ  ବି ୟୋଗ କରାଯାଏ, ତେବେ ଅବଶି ଷ୍ଟ ପରି ମାଣ 3:7:11
ଅନୁ ପାତରେ ରହି ବ । ବି ୟୋଗ ପରେ X ଙ୍କ ଭାଗ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  ₹1704

B.  ₹1754

C.  ₹1554

D.  ₹1854

✓

Q13 Quant
ଏକ ଭାଗକ୍ରି  ୟାରେ ଭାଜକଟି  ଭାଗଫଳର 20 ଗୁ ଣ ଏବଂ ଭାଗଶେଷର 5 ଗୁ ଣ ଅଟେ । ଯଦି
ଭାଗଶେଷ 76 ହୁ ଏ, ତେବେ ଭାଜ୍ୟ କେତେ ହେବ?

A.  7296

B.  7301

C.  7292

D.  7295

✓

Q14 Quant
ଅମି ତ ବାର୍ଷିକ 10% ସୁ ଧ ହାରରେ 2 ବର୍ଷ  ପାଇଁ  ଦୁ ଇଟି  ଯୋଜନାରେ ସମାନ ପରି ମାଣର
ରାଶି  ନି ବେଶ କରି ଥି ଲେ: ଗୋଟି ଏ ସରଳ ସୁ ଧ ଏବଂ ଅନ୍ୟଟି  ଚକ୍ର ବୃ ଦ୍ଧି  ସୁ ଧ ହାରରେ ।
ଶେଷରେ ଚକ୍ର ବୃ ଦ୍ଧି  ସୁ ଧ ସରଳ ସୁ ଧ ଅପେକ୍ଷା ₹40 ଅଧି କ ଥି ଲା । ପ୍ର ତ୍ୟେକ ଯୋଜନାରେ ସେ
ନି ବେଶ କରି ଥି ବା ରାଶି  (₹ ରେ) ନି ର୍ଣ୍ଣ ୟ କର ।

A.  4000

B.  5000

C.  6000

D.  8000

✓

Q15 Quant
ଲବ୍ଧାଙ୍କ 26, 25, 55, 41, 29, 64, 86, 56 ଓ 32 ର ସମାନ୍ତର ମଧ୍ୟକ କେତେ?

A.  46

B.  37

C.  55

D.  50

✓

Q16 Quant
ଏକ ଆୟତକ୍ଷେତ୍ର ର ପରି ସୀମା ଓ ପ୍ର ସ୍ଥ ମଧ୍ୟରେ ଅନୁ ପାତ 4 : 1 ଅଟେ । ଯଦି

ଆୟତକ୍ଷେତ୍ର ର କ୍ଷେତ୍ର ଫଳ 289 cm2 ହୁ ଏ, ତେବେ ଆୟତକ୍ଷେତ୍ର ର ପରି ସୀମା (cm ରେ)
ନି ର୍ଣ୍ଣ ୟ କର ।

A.  68

B.  72

C.  64

D.  60

✓

Q17 Quant
ରଞ୍ଜି ତ ସମାନ ମୂ ଲ୍ୟରେ ଦୁ ଇଟି  ମୋବାଇଲ କି ଣି ଲେ । ସେ ଗୋଟି ଏକୁ  20% ଲାଭରେ ଏବଂ
ଅନ୍ୟଟି କୁ  10% କ୍ଷତି ରେ ବି କ୍ରି   କଲେ । ତାଙ୍କର ସାମଗ୍ରି  କ ଲାଭ ପ୍ର ତି ଶତ କେତେ?

A.  5%

B.  6.5%

C.  6%

D.  5.5%
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✓

Q18 Quant

9 cm ବ୍ୟାସାର୍ଦ୍ଧ  ବି ଶି ଷ୍ଟ ଏକ ନି ଦା ଗୋଲକକୁ  ତରଳାଯାଇ 1 cm ବ୍ୟାସାର୍ଦ୍ଧ  ବି ଶି ଷ୍ଟ ଏକ ସମ ବୃ ତ୍ତାକାର ପ୍ର ସ୍ଥ-ଛେଦ ବି ଶି ଷ୍ଟ ତାରରେ ପରି ଣତ କରାଯାଏ । ତାରର ଦୈ ର୍ଘ୍ୟ  କେତେ? [π =

ବ୍ୟବହାର କର]

A.  9.12 m

B.  9.32 m

C.  9.72 m

D.  9.92 m

✓

Q19 Quant

ଯଦି  a + b + c = 16 ଏବଂ ab +bc + ac = 39 ହୁ ଏ, ତେବେ  ର ମୂ ଲ୍ୟ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  178

B.  100

C.  149

D.  134

✓

Q20 Quant
ସରଳ କର ଏବଂ କ୍ଷୁ ଦ୍ର ତମ ପଦରେ ମୂ ଲ୍ୟ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  

B.  

C.  

D.  
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GA

✓

Q21 GA
2025 ଡ୍ରୋ ମି ଆ ଇଣ୍ଟରନ୍ୟାସନାଲ ସ୍ପ୍ରି ଣ୍ଟ ଆଣ୍ଡ ରି ଲେସ ମି ଟିଂ  (Dromia International
Sprint and Relays Meeting) ରେ ପୁ ରୁ ଷ 100 ମି ଟର ଦୌଡ଼ରେ ଜାତୀୟ ରେକର୍ଡ଼
ଭାଙ୍ଗି , ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କି ଏ ଭାରତର ସର୍ବା ଧି କ ଦ୍ରୁ ତତମ ମାନବ ହୋଇପାରି ଥି ଲେ?

A.  ଗୁ ରି ନ୍ଦରବୀର ସିଂ ହ

B.  ଅନି ମେଷ କୁ ଜୁ ର

C.  ମହମ୍ମଦ ଅଫସାଲ

D.  ଜି ନସନ ଜନସନ

✓

Q22 GA
ରାଜମହଲ ପର୍ବ ତମାଳା ଭାରତର କେଉଁ  ରାଜ୍ୟରେ ଅବସ୍ଥି ତ?

A.  ରାଜସ୍ଥାନ

B.  ମେଘାଳୟ

C.  ଝାଡଖଣ୍ଡ

D.  ତେଲେଙ୍ଗାନା

✓

Q23 GA
ସେପ୍ଟେମ୍ବର 2025 ସୁ ଦ୍ଧା ଓଡ଼ି ଶାର ମୁ ଖ୍ୟମନ୍ତ୍ରୀ କି ଏ?

A.  ପ୍ର ଦୀପ କୁ ମାର ଅମତ

B.  ବି ଶ୍ୱ ଭୂ ଷଣ ହରି ଚନ୍ଦନ

C.  ନବୀନ ପଟ୍ଟନାୟକ

D.  ମୋହନ ଚରଣ ମାଝୀ

✓

Q24 GA
ବି ଶ୍ୱର ସର୍ବ ବୃ ହତ ରଙ୍ଗମଞ୍ଚ ମହୋତ୍ସବ ଭାବେ ପରି ଚି ତ ତଥା ସମଗ୍ର  ଭାରତର ବି ଭି ନ୍ନ
ସହରରେ ଆକର୍ଷ ଣୀୟ ନାଟ୍ୟ ପରି ବେଷଣ କରି ଥି ବା 25 ତମ 'ଭାରତ ରଙ୍ଗ ମହୋତ୍ସବ'
(BRM) କେଉଁ  ସଂସ୍ଥା ଦ୍ୱାରା ଆୟୋଜି ତ ହୋଇଥାଏ?

A.  ନ୍ୟାସନାଲ ସ୍କୁଲ ଅଫ ଡ୍ରା ମା

B.  ସଙ୍ଗୀତ ନାଟକ ଏକାଡେମୀ 

C.  ଇନ୍ଦି ରା ଗାନ୍ଧୀ ଜାତୀୟ କଳା କେନ୍ଦ୍ର

D.  ଭାରତୀୟ ସାଂସ୍କୃତି କ ସମ୍ବନ୍ଧ ପରି ଷଦ

✓

Q25 GA
ଏକ ଉତ୍ତଳ ଲେନ୍ସ  ସମ୍ମୁଖରେ 15 cm ଦୂ ରତାରେ ଏକ ବସ୍ତୁକୁ  ରଖି ଲେ, ଲେନ୍ସ ଠାରୁ  30 cm
ଦୂ ରରେ ଏକ ପ୍ର ତି ବି ମ୍ବ ଗଠନ ହୁ ଏ । ବସ୍ତୁର ଉଚ୍ଚତା 5 cm ଅଟେ । ଯଦି  ଏହାର ପରି ଣାମୀ
ପରି ବର୍ଦ୍ଧ ନ m = −2 ଭାବରେ ଗଣନା କରାଯାଏ, ତେବେ ପ୍ର ତି ବି ମ୍ବର ଉଚ୍ଚତା ଏବଂ ଏହାର
ପ୍ର କୃ ତି  କଣ ହେବ?

A.  ପ୍ର ତି ବି ମ୍ବ ଉଚ୍ଚତା 10 cm, ଆଭାସୀ ଏବଂ ସଳଖ 

B.  ପ୍ର ତି ବି ମ୍ବ ଉଚ୍ଚତା − 10 cm, ବାସ୍ତବ ଏବଂ ଓଲଟା

C.  ପ୍ର ତି ବି ମ୍ବ ଉଚ୍ଚତା − 2.5 cm, ବାସ୍ତବ ଏବଂ ଓଲଟା

D.  ପ୍ର ତି ବି ମ୍ବ ଉଚ୍ଚତା 10 cm, ବାସ୍ତବ ଏବଂ ଓଲଟା

✓

Q26 GA
କାର୍ବ ନ କାହିଁକି  ଆୟନି କ ବନ୍ଧ ବଦଳରେ ସହସଂଯୋଜକ ବନ୍ଧ ଗଠନ କରେ?

A.  ଏହାର ସହଜରେ ଚାରୋଟି  ଇଲେକ୍ଟ୍ରନ୍  ହରାଇବାର ପ୍ର ବୃ ତ୍ତି  ଅଛି

B.  ଏହା ସହଜରେ ଚାରୋଟି  ଇଲେକ୍ଟ୍ରନ୍  ହରାଇପାରେ ନାହିଁ କି ମ୍ବା ଲାଭ କରି ପାରେ
ନାହିଁ, ତେଣୁ  ଏହା ଇଲେକ୍ଟ୍ରନ୍  ବାଣ୍ଟି ଥାଏ

C.  ଏହାର ସହଜରେ ଚାରୋଟି  ଇଲେକ୍ଟ୍ରନ୍  ଲାଭ କରି ବାର ପ୍ର ବୃ ତ୍ତି  ଅଛି

D.  ଏହାର ଏକ ସମ୍ପୂ ର୍ଣ୍ଣ  ବାହ୍ୟ ସେଲ ଅଛି

✓

Q27 GA
ଭାରତରେ ଥି ବା ଥର ମରୁ ଭୂ ମି ର ସୀମା ସମ୍ବନ୍ଧରେ ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ  ଯୋଡ଼ି ଟି  ଭୁ ଲ
ଅଟେ?

A.  ଉତ୍ତର-ପଶ୍ଚି ମ – ଲୁ ଣି  ନଦୀ

B.  ପୂ ର୍ବ  – ଆରାବଳୀ ରେଞ୍ଜ

C.  ଦକ୍ଷି ଣ – କଚ୍ଛର ରଣ

D.  ପଶ୍ଚି ମ – ସି ନ୍ଧୁ  ନଦୀ 

✓

Q28 GA
ମନୁ ଷ୍ୟ ଶରୀରର ପାଚନ ତନ୍ତ୍ର ଏବଂ ସେଥି ରୁ  ନି ର୍ଗ ତ ପାଚକ ରସ ଉପରେ ଆଧାର କରି ,
ନି ମ୍ନ ଲି ଖି ତ ସାଦୃ ଶ୍ୟ କୁ  ପୂ ର୍ଣ୍ଣ  କରନ୍ତୁ ।

ପାଟି : ଲାଳ ଆମାଇଲେଜ :: ପାକସ୍ଥଳୀ:?

A.  ଲାଇପେଜ

B.  ଟ୍ରି  ପସି ନ

C.  ପେପସି ନ 

D.  ଆମାଇଲେଜ

✓

Q29 GA
ପ୍ର ଥମ "ଫେମି ନା ଆଚି ଭର୍ସ  ଆୱାର୍ଡ ସ 2025: ଓଡ଼ି ଶା ଏଡି ସନ" ରେ ସଙ୍ଗୀତରେ ଉତ୍କର୍ଷ ତା
ପାଇଁ  ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ନାମକୁ  ସମ୍ମାନି ତ କରାଯାଇଥି ଲା ?

A.  ଆଦ୍ୟାଶା ସତପଥୀ 

B.  ଅଙ୍କି ତା ମହାନ୍ତି  

C.  ଅନ୍ତରା ଚକ୍ର ବର୍ତ୍ତୀ  

D.  ଅର୍ପିତା ମହାପାତ୍ର  

✓

Q30 GA
ପ୍ର ଭୁ  ଜଗନ୍ନାଥ ଏବଂ ପୌରାଣି କ ବି ଷୟବସ୍ତୁର ଚି ତ୍ର ଣ ପାଇଁ  ଜଣାଶୁ ଣା ଓଡ଼ି ଶାର ପାରମ୍ପରି କ
ଚି ତ୍ର କଳା ଶୈ ଳୀକୁ  କ'ଣ କୁ ହାଯାଏ?

A.  ୱାର୍ଲି 

B.  ପଟ୍ଟଚି ତ୍ର

C.  କଲମକାରୀ

D.  ମଧୁ ବନୀ
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✓

Q31 GA
ଧାରଣୀୟ ବି କାଶ (Sustainable Development) ର ସଂଜ୍ଞା କେଉଁ  ରି ପୋର୍ଟ ରେ ପ୍ର ଥମେ
ନି ର୍ଦ୍ଦିଷ୍ଟ ଭାବରେ ପ୍ର ଦାନ କରାଯାଇଥି ଲା?

A.  ରି ଓ ଘୋଷଣାନାମା

B.  ଆମର ସାଧାରଣ ଭବି ଷ୍ୟତ 

C.  କ୍ୟୋଟୋ ପ୍ରୋ ଟୋକଲ

D.  ଅଭି ବୃ ଦ୍ଧି ର ସୀମା 

✓

Q32 GA
ଓଡ଼ି ଶାର କେଉଁ  ଅଞ୍ଚଳରେ ସର୍ବା ଧି କ ଆର୍ଦ୍ର ତା ଅନୁ ଭବ ହୋଇଥାଏ?

A.  ଉପକୂ ଳ ଅଞ୍ଚଳ

B.  ମାଳଭୂ ମି  ଅଞ୍ଚଳ

C.  ପାର୍ବ ତ୍ୟ ଅଞ୍ଚଳ

D.  ଜଙ୍ଗଲ ଅଞ୍ଚଳ

✓

Q33 GA
ଭାରତୀୟ ଜାତୀୟ ଆନ୍ଦୋଳନ (1919-1947) ର ଗାନ୍ଧୀବାଦୀ ପର୍ଯ୍ୟା ୟରେ, ସାଇମନ୍
କମି ଶନର ବି ଫଳତା ଏବଂ ପୂ ର୍ଣ୍ଣ  ସ୍ୱାଧୀନତା ଦାବି  ପରି ପ୍ରେ କ୍ଷୀରେ ମହାତ୍ମା ଗାନ୍ଧୀ ନି ମ୍ନ ଲି ଖି ତ
ମଧ୍ୟରୁ  କେଉଁ  ଆନ୍ଦୋଳନ ଆରମ୍ଭ କରି ଥି ଲେ?

A.  ଅସହଯୋଗ ଆନ୍ଦୋଳନ

B.  ଆଇନ ଅମାନ୍ୟ ଆନ୍ଦୋଳନ

C.  ଭାରତ ଛାଡ଼ ଆନ୍ଦୋଳନ

D.  ଖି ଲାଫତ ଆନ୍ଦୋଳନ

✓

Q34 GA
ICC ମହି ଳା ବି ଶ୍ୱକପ 2025 ରେ କେଉଁ  ଦଳ ଚାମ୍ପି ଅନ ହୋଇଥି ଲା?

A.  ଅଷ୍ଟ୍ରେଲି ଆ

B.  ଇଂଲଣ୍ଡ

C.  ଦକ୍ଷି ଣ ଆଫ୍ରି  କା

D.  ଭାରତ

✓

Q35 GA
କେଉଁ  ଭାରତୀୟ ରାଜ୍ୟ 1 ଏପ୍ରି  ଲ 2026 ରେ ଜୀବନଯାପନ ପ୍ର ଣାଳୀକୁ  ଚାର୍ଟ  କରି ବା,
ବେକାରୀ ସମସ୍ୟାର ଧାରାକୁ  ଯାଞ୍ଚ କରି ବା ଏବଂ ନି ଶାଦ୍ର ବ୍ୟର ଅପବ୍ୟବହାର ପରି ମାଣକୁ
ମୂ ଲ୍ୟାଙ୍କନ କରି ବା ପାଇଁ  ଏହାର ପ୍ରା ରମ୍ଭି କ ଔଷଧ ଏବଂ ଜାତି  ସାମାଜି କ-ଅର୍ଥ ନୈ ତି କ
ଅଧ୍ୟୟନ ଆରମ୍ଭ କରି ଥି ଲା?

A.  ପଞ୍ଜାବ

B.  ରାଜସ୍ଥାନ

C.  ବି ହାର

D.  ମହାରାଷ୍ଟ୍ର

✓

Q36 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ  ବି ବୃ ତି ଟି  ଭାରତୀୟ ସମ୍ବି ଧାନର ରାଷ୍ଟ୍ର ନି ର୍ଦ୍ଦେ ଶକ ନୀତି କୁ
ସର୍ବୋ ତ୍ତମ ଭାବରେ ବର୍ଣ୍ଣ ନା କରେ?

A.  ସେଗୁ ଡ଼ି କ ନ୍ୟାୟାଳୟ ଦ୍ୱାରା କାର୍ଯ୍ୟ କାରୀ ଅଟେ । 

B.  ସେଗୁ ଡି କ ସରକାରଙ୍କ ପାଇଁ  ନୀତି  ପ୍ର ଣୟନ କରି ବାର ନି ର୍ଦ୍ଦେ ଶାବଳୀ ଅଟେ ।

C.  ସେଗୁ ଡି କ କେବଳ ଜରୁ ରୀକାଳୀନ ପରି ସ୍ଥି ତି ରେ ଲାଗୁ  ହୋଇଥାଏ ।

D.  ସେଗୁ ଡି କ କେବଳ କେନ୍ଦ୍ର ସରକାରଙ୍କ କ୍ଷେତ୍ର ରେ ହିଁ ପ୍ର ଯୁ ଜ୍ୟ ଅଟେ ।

✓

Q37 GA
Which of the following classical dance forms originated from Tamil
Nadu?

A.  Kathak

B.  Bharatanatyam

C.  Manipuri

D.  Sattriya

✓

Q38 GA
ନି ମ୍ନ ଲି ଖି ତ ଲୋକନୃ ତ୍ୟ ବା ଆଦି ବାସୀ ନୃ ତ୍ୟମାନଙ୍କ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଏହାର ମୁ ଖ୍ୟ ଅଞ୍ଚଳ
ସହି ତ ସଠି କ ଭାବରେ ମେଳ ଖାଉଛି ?

A.  ସାନ୍ତାଳି  ନୃ ତ୍ୟ – ଗୁ ଜରାଟ

B.  ବାଇସନ -ହର୍ନ  ମାରି ଆ ନୃ ତ୍ୟ – ଛତି ଶଗଡ଼

C.  ଗି ଦ୍ଧା - କେରଳ

D.  ଛଉ – ଗୋଆ

✓

Q39 GA
ଭାବର ଅଞ୍ଚଳ (Bhabar belt) କେଉଁ  ପର୍ବ ତମାଳା ସହି ତ ସମାନ୍ତରାଳ ଭାବରେ ଅବସ୍ଥି ତ?

A.  ଆରାବଳୀ ପର୍ବ ତମାଳାର ପ୍ର ଣାଳୀ

B.  ବି ନ୍ଧ୍ୟ ପର୍ବ ତମାଳା ପ୍ର ଣାଳୀ

C.  ଶି ବାଲି କ ପାଦଦେଶ ପ୍ର ଣାଳୀ

D.  ପଶ୍ଚି ମ ଘାଟ ପର୍ବ ତମାଳା ପ୍ର ଣାଳୀ

✓

Q40 GA
ମାନବ ବି କାଶ ଧାରଣା ସହ ଜଡ଼ି ତ ଜଣେ ବି ଶି ଷ୍ଟ ଅର୍ଥ ନୀତି ଜ୍ଞ ଡକ୍ଟର ମହବୁ ବ ଉଲ ହକ
କେଉଁ  ଦେଶର ମୂ ଳ ବାସି ନ୍ଦା ଥି ଲେ?

A.  ପାକି ସ୍ତାନ

B.  ଇରାନ

C.  ସାଉଦି  ଆରବ

D.  ଆଫଗାନି ସ୍ତାନ
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English

✓

Q41 English
Select the appropriate option to complete the sentence.

It was ___ honor to meet ___ astronaut who visited our school.1619

A.  a, an

B.  an, a

C.  an, an

D.  a, a

✓

Q42 English
Select the option that can be used as a one-word substitute for the given group of words.

The fear of open or public spaces

A.  Claustrophobia

B.  Agoraphobia

C.  Xenophobia

D.  Acrophobia

✓

Q43 English

Select the correct Active form of the following sentence.

The house was cleaned by Sarah every Sunday.

A.  Sarah cleaned the house every Sunday.

B.  Sarah will clean the house every Sunday.

C.  Sarah is cleaning the house every Sunday.

D.  Sarah has cleaned the house every Sunday.

✓

Q44 English
Select the most appropriate idiom to replace the underlined words in the sentence below.

The firefighters reached the burning building at the last possible moment to save the people trapped inside.

A.  in the nick of time

B.  like a blessing in disguise

C.  once in a blue moon

D.  under the weather

✓

Q45 English
Identify the sentence from the options that is incorrectly written in indirect speech.

A.  She said that she had finished her homework.

B.  She said that she has finished her homework.

C.  She said that she would call me later.

D.  She said that she was feeling unwell.
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✓

Q46 English
Choose the option that can substitute the underlined idiom seamlessly.

After hours of discussion, she finally bit the bullet and accepted the responsibility.

A.  faced the difficulty

B.  ignored the issue

C.  ran away

D.  postponed the decision

✓

Q47 English
Choose the correct form of past tense of the verb given in the bracket to complete the given sentence.
I __________ (excite) to share how I met my new friend.

A.  had excitement

B.  am excited

C.  had been excited

D.  was exciting

✓

Q48 English

Read the passage and answer the questions that follow.

Summer is a popular time for pilgrimage in India, as it coincides with several religious festivals and offers favourable weather conditions for
travel to many sacred sites. These pilgrimage destinations in India offer not just spiritual solace but also an opportunity to immerse oneself in
the rich cultural heritage and traditions that define the country's religious landscape. Whether braving treacherous mountain trails or seeking
solace in serene temple towns, pilgrims embark on a journey of self-discovery and enlightenment, guided by unwavering faith and devotion.

Vaishno Devi Temple, nestled in the picturesque Trikuta Mountains in Katra, Jammu, is dedicated to Goddess Vaishno Devi. Pilgrims embark on a
challenging trek, covering approximately 13 kilometres from the base camp at Katra to the temple located at an altitude of around 5,200 feet.
The journey, though strenuous, is undertaken with unwavering faith and devotion.

Select an appropriate title for the passage.

A.  The Summer Sun

B.  Faith on the Mountain Trails

C.  Trek to the Northern Peaks

D.  India’s Summer Pilgrimages of Devotion

✓

Q49 English
Select an appropriate structure of the passage.

A.  Description

B.  Comparison

C.  Argument

D.  Narrative
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✓

Q50 English
Select an appropriate meaning of the word: TREACHEROUS

A.  Smooth

B.  Dangerous

C.  Pleasant

D.  Effortless

✓

Q51 English
Select the most appropriate theme of the passage.

A.  Spiritual journeys that blend devotion with endurance

B.  The architectural styles of Indian temples

C.  Weather conditions affecting Indian tourism

D.  Myths surrounding Indian deities

✓

Q52 English
Select an appropriate inference drawn from the passage.

A.  Pilgrimage in India is both a test of endurance and a spiritual pursuit.

B.  People travel mainly for adventure rather than faith.

C.  The summer season discourages religious travel.

D.  The Vaishno Devi trek is purely recreational.

✓

Q53 English
Sentences of a paragraph are given below. While the first sentence (A) is in the correct order, the sentences below it are jumbled up. Arrange
the sentences in the correct order to form a meaningful and coherent paragraph.

A. Climate change is one of the most pressing challenges facing the world today.
B. Many countries are investing in renewable energy to reduce carbon emissions.
C. Scientists warn that failure to act now could lead to irreversible damage.
D. Rising global temperatures are causing glaciers to melt and sea levels to rise.
E. Governments and individuals must work together to create sustainable solutions.

A.  ABCDE

B.  ACDBE

C.  ADBCE

D.  AEDCB

✓

Q54 English
Choose the correct antonym for the underlined word from the options.
The scientist learnt to manipulate the data carefully to reveal meaningful patterns and insights.

A.  mishandle

B.  break

C.  boost

D.  anticipate
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✓

Q55 English
Identify the misspelt word in the given sentence.

The engineers discussed the feasable methods for storing excess solar energy during peak production.

A.  feasable

B.  storing

C.  excess

D.  peak

✓

Q56 English
Identify the antonym of the highlighted word in the sentence.

The once arid land was transformed into a fertile field through irrigation.

A.  Rocky

B.  Elevated

C.  Moist

D.  Dusty

✓

Q57 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

A. in the tranquil garden
B. the old oak tree stands tall
C. providing shade and solace
D. to those seeking refuge

A.  ABCD

B.  BADC

C.  ABDC

D.  DCAB

✓

Q58 English
Select the most appropriate option to fill in the blank.

By next year, she ______ in this company for a decade.

A.  will have worked

B.  have worked

C.  worked

D.  will work
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✓

Q59 English
Select the option that can be used as a one-word substitute for the highlighted group of words.

She tried to pretend to feel or be affected by something, especially an emotion or illness, but her lack of real tears gave her away.

A.  Reveal

B.  Feign

C.  Express

D.  Confess

✓

Q60 English
Select the most appropriate option to fill in the blank.

The scientist’s theory, though radical, was supported by ______ data that few in the academic community could refute.

A.  speculative

B.  irrefutable

C.  fragmented

D.  circumstantial

Odia

✓

Q61 Odia
ଭବି ଷ୍ୟତରେ ସେ ଜଣେ ଡାକ୍ତର ହେବେ - ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଏହି  ବାକ୍ୟର ଠି କ୍  ଅନୁ ବାଦ ବାଛ ।

A.  In future, he will become a doctor.

B.  He will become a doctor in the future.

C.  He will become a doctor in future.

D.  He will become an doctor in future.

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ଶବ୍ଦଗୁ ଡ଼ି କର ସମାନାର୍ଥ ବୋଧକ ଶବ୍ଦ ଲେଖ।
ପି ଲାମାନେ ଖେଳୁ ଥି ବା ବେଳେ ବହୁ ତ "ଆନନ୍ଦ" ଅନୁ ଭବ କରନ୍ତି ।

A.  ଦୁଃ ଖ

B.  ଖୁ ସି

C.  କ୍ରୋ ଧ

D.  ଭୟ

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଭାରତ ଏକ ବହୁ  ଧର୍ମୀ ୟ ଦେଶ ଯେଉଁ ଠାରେ ବି ଭି ନ୍ନ ଲୋକ ଭି ନ୍ନ ଆସ୍ଥା ମାନି ଥାନ୍ତି  ।

A.  India is a multi-religious country where people practice different faiths freely.

B.  India is multi-religious country where people practice different faiths freely.

C.  India are a multi-religious country where people practice different faiths freely.

D.  India is a multi-religious country where people practices different faiths freely.
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✓

Q64 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ରାଷ୍ଟ୍ରପତି  ଆଜି  କେରଳ ଗସ୍ତରେ ଯି ବେ।

A.  The President has visited Kerala today.

B.  The President will visit Kerala today.

C.  The President will visit Kerala .

D.  The President was visiting Kerala today.

✓

Q65 Odia

ନି ମ୍ନୋ କ୍ତ ଅନୁ ଚ୍ଛେଦକୁ  ପଢି  ପ୍ର ଶ୍ନ ଗୁ ଡି କର ଉତ୍ତର ଚୟନ କର ।

ସାରା ଦେଶରେ ଦି " ଓଳି  ଦି ' ମୁ ଠା ଖାଇବାକୁ  ପାଇ ନଥୁ ବା ଅଗଣି ତ ମଣି ଷଙ୍କୁ  ଦେଖି  ବି ବେକାନନ୍ଦ ଗୋଟି ଏ ନୂ ତନ ଜ୍ଞାନ ପାଇଲେ । ତାହା ହେଉଛି , “ଭୋକି ଲା ପେଟରେ ଧର୍ମ  ଅନାବଶ୍ୟକ’ । ଉକ୍ତି ଟି

ମାର୍କ ସ ବା ତାଙ୍କର ଅନୁ ଗାମୀଙ୍କର ବୋଲି  ଅନୁ ମାନ କରି ନେବା ସ୍ଵାଭାବି କ । କି ନ୍ତୁ ଏ ପଦଟି  ନରେନ୍  ରାମକୃ ଷ୍ଣଙ୍କ ଠାରୁ  ଶୁ ଣି ଥି ଲେ । ଦେଶର ଅନ୍ଦି କନ୍ଦି  ବୁ ଲି  ଏହାର ସତ୍ୟତାକୁ  ମର୍ମେ  ମର୍ମେ  ଅନୁ ଭବ
କଲେ । ସେ ଠି କ୍  କଲେ, ଦରି ଦ୍ର ନାରାୟଣଙ୍କ ସେବା ହିଁ ସନ୍ନ୍ୟାସୀର ଯଥାର୍ଥ  ବ୍ର ତ । ଦେଶସାରା ଦାରି ଦ୍ର୍ୟ ର ନି ରଙ୍କୁ ଶ ରାଜତ୍ଵ ଦେଖି  ବି ବେକାନନ୍ଦ ଆପଣାକୁ  ଓ ସନ୍ନ୍ୟାସୀକୁ  ଧି କ୍ ‌କାର କରି  ଭାବୁ ଥି ଲେ “
ବୁ ଭୁ କ୍ଷୁ  ଜନତା ପାଇଁ  ଆମେ ସନ୍ନ୍ୟାସୀଗଣ କ’ଣ କରି ଛୁ  ?’’ ଜୟ ପରାଜୟ ଊର୍ଦ୍ଧ କୁ  ଉଠି ଥ‌ି ବା ଅନାସକ୍ତ ସନ୍ନ୍ୟାସୀ ବ୍ୟତୀତ ଆଉ କି ଏ ପ୍ର ବଳ ପ୍ର ତାପୀ ଓ ଅଜେୟ ଦାରି ଦ୍ର୍ୟ  ଦାନବ ବି ରୋଧରେ ଖଡ୍ ‌ଗ
ଉତ୍ତୋଳନ କରି ପାରେ ? ଯୁ ଗ ଯୁ ଗ ଧରି  ସିଂ ହାସନରେ ଅଧି ଷ୍ଠି ତ ପ୍ର ତାପୀ ସମ୍ରା ଟଙ୍କ ବି ରୋଧରେ ସଂଗ୍ରା ମର ଫଳାଫଳକୁ  ନି ଜର ଶୌର୍ଯ୍ୟ ବୀର୍ଯ୍ୟ  ଦ୍ଵାରା ନ ମାପି  ସୁ ପ୍ତ କାତି ର ଶକ୍ତି  କଳି ଥି ବା ଦି ବ୍ୟଦଷ୍ଟା

ସନ୍ନ୍ୟାସୀ ବ୍ୟତୀତ ଆଉ କି ଏ ରଣଦୂ ନ୍ଦୁ ଭି  ବଜାଇ ଯୁ ଦ୍ଧର ଡାକରା ଦେଇପାରେ ? ଏ ଦାନବ ପାଇଁ  ଦଧି ଚି ଙ୍କ ପରି  ଜଣେ ମହର୍ଷିଙ୍କ ଅସ୍ଥି ରେ ନି ର୍ମିତ ଅମୋଘ ଅସ୍ତ୍ର ମଧ୍ୟ ଯଥେଷ୍ଟ ନୁ ହେଁ  ! ମଣି ଷଙ୍କର
ଦୀର୍ଘ ଶ୍ଵାସ ଓ ଅଶ୍ରୁ ରୁ  ଶତ୍ରୁ  ସଂହାର ଅସ୍ତ୍ର ଜାଣି ଥି ବା ତରୁ ଣ ସନ୍ନ୍ୟାସୀ। ପ୍ର ତି ଟି  ଆର୍ତ୍ତ ନାଦ ଓ ପ୍ର ତି ବୁ ନ୍ଦା ଅଶ୍ରୁ କୁ  ସଂଗ୍ର ହ କରି  ତାଙ୍କ ବି ଶାଳ ହୃ ଦୟରେ ସଞ୍ଚି  ରଖି ବା ପାଇଁ  ଆକୁ ମାରୀହି ମାଚଳ ପଦବ୍ର ଜରେ

ବୁ ଲି ଥି ଲେ । ଯାତ୍ରା  ଆରମ୍ଭ ହୋଇଥି ଲା ବରାହନଗରରୁ  । କେଉଁ ଠି  ଯାଇ ରାଜପୁ ତନା, ଜୟପୁ ର, ଆଜ୍ ‌ମୀର । ସେଠାରୁ  ପୁ ଣି  ଜୁ ନାଗଡ଼, ପୋରବନ୍ଦର, ଦ୍ଵାରକା, ବମ୍ବେ, ପୁ ନା । ଶେଷରେ ବି ବେକାନନ୍ଦ
ଦକ୍ଷି ଣରେ ପହଞ୍ଚି ଥି ଲେ । ସାରା ଦେଶରେ ଏହି  ଅଚି ହ୍ନା ସନ୍ନ୍ୟାସୀ ଅନେକ ଗୁ ଣମୁ ଗ୍ ‌ଧ ବନ୍ଧୁ , ସହକର୍ମୀ  ଓ ଅନୁ ଗତ ଶି ଷ୍ୟ ସୃ ଷ୍ଟି  କରି ଥି ଲେ ମଧ୍ୟ ମାଡ୍ରା ସରେ ତାଙ୍କର ପ୍ର ଭାବ ବି ଶେଷ ଭାବେ ଅନୁ ଭୂ ତ

ହୋଇଥି ଲା । ଯୁ ଦ୍ଧ ଘୋଷଣା କରି ବା ପୂ ର୍ବ ରୁ  ଛତ୍ର ପତି  ସନ୍ନ୍ୟାସୀ ବେଶରେ ତାଙ୍କର ଯୋଦ୍ଧାମାନଙ୍କୁ  ଠାବ କରି ଗଲେ । ଧନୀ ରାଜା ମହାରାଜା ବଡ଼ ବଡ଼ ପଣ୍ଡି ତମାନଙ୍କଠାରୁ  ଆରମ୍ଭ କରି  ସାଧାରଣ ଜନତା
ମଧ୍ୟରେ ଥି ବା ଅନୁ ରକ୍ତ ସୈ ନି କମାନେ ଏହି  ଛଦ୍ମ ବେଶୀ ଛତ୍ର ପତି ଙ୍କଠାରୁ  କି  ଏକ ରହସ୍ୟମୟ ଇସାରା ପାଇ ଆଦେଶକୁ  ଅପେକ୍ଷା କରି  ରହି ଲେ । ଧନୀ, ଦରି ଦ୍ର , ମୂ ର୍ଖ , ପଣ୍ଡି ତ, ନି ର୍ବିଶେଷରେ ଏତେ

ଲୋକ ଜଣେ ନିଃ ସ୍ଵ ସନ୍ନ୍ୟାସୀ ପ୍ର ତି  ଆକୃ ଷ୍ଟ ହୋଇଥି ଲେ କାହିଁକି  ? କି ଛି  ହଟଚମକ ବି ଦ୍ୟା ଦେଖି  ନୁ ହେଁ  କି ମ୍ବା ‘ମୋ ଶି ଷ୍ୟ ହେଲେ ବା ମୋତେ ପୂ ଜା କଲେ ଆଉ ଗୋଟାଏ ବଡ଼ ରାଜ୍ୟ ମି ଳି ବ, ବଡ଼
ଚାକି ରି  ମି ଳି ବ’-ଏପରି  ପ୍ର ତି ଶ୍ରୁ ତି  ପାଇ ନୁ ହେଁ  । କ’ଣ ପାଇଁ , କି  ଶକ୍ତି  ଦେଖି  ତାଙ୍କ ସଂସ୍ପର୍ଶ ରେ ଆସୁ ଥି ବା ଲୋକଙ୍କର ବଞ୍ଚି ବାର ଢଙ୍ଗ ବଦଳି  ଯାଉଥି ଲା

ଅନୁ ଛେଦଟି ର ଗଢଣଟି କୁ  ଚୟନ କର ।

A.  ଶି କ୍ଷା ଓ ସଂସ୍କୃତି

B.  ସତ୍ୟ ଓ ନ୍ୟାୟ

C.  ମଣି ଷର ସଭ୍ୟ ଆଚରଣ

D.  ମାତୃ ଭାଷା ଓ ଲୋକଶି କ୍ଷା

✓

Q66 Odia
ଏହି  ଅନୁ ଛେଦଟି ରେ କେଉଁ  ସ୍ଵରକୁ  ଅଧି କ ଗୁ ରୁ ତ୍ଵ ଦି ଆଯାଇଛି  ?

A.  ପ୍ରେ ମ

B.  ଦୟା

C.  ସମ୍ପର୍କ  ଓ ଭଲପାଇବା

D.  ସହାନୁ ଭୁ ତି

✓

Q67 Odia
ଯୁ ଦ୍ଧ ଘୋଷଣା କରି ବା ପୂ ର୍ବ ରୁ  ଛତ୍ର ପତି  କେଉଁ  ବେଶରେ ଯୋଦ୍ଧାମାନଙ୍କୁ  ଠାବ କରି ଥି ଲେ ବୋଲି  କୁ ହାଯାଇଛି  ?

A.  ନାରୀ ବେଶ

B.  ବ୍ରା ହ୍ମଣ ବେଶ

C.  ପାରମ୍ପରି କ ବେଶ

D.  ସନ୍ନ୍ୟାସୀ
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✓

Q68 Odia
‘ଭୋକି ଲା ପେଟରେ ଧର୍ମ  ଅନାବଶ୍ୟକ’- ଏହି  ଉକ୍ତି ଟି  ନରେନ୍  କାହାଠୁ  ଶୁ ଣି ଥି ଲେ ?

A.  ବି ବେକାନନ୍ଦ

B.  ମାର୍କ ସ

C.  ମହାତ୍ମା ଗାନ୍ଧୀ

D.  ରାମକୃ ଷ୍ଣ

✓

Q69 Odia
ଜଣେ ସଭ୍ୟ ମଣି ଷ ଭାବେ କି ପରି  ପରି ଚି ତ ହୁ ଏ ?

A.  ଅସଭ୍ୟତା ଦ୍ୱାରା

B.  ଶି ଷ୍ଟ ଓ ସଂସ୍କାରୀ

C.  ଅଳସ

D.  ଅନି ୟମି ତ

✓

Q70 Odia
ତୁ ମେ ଯି ବ ଯେ କଥାଟି  କି ନ୍ତୁ କଥା ଭଲ ହେବନି  । ଏହି  ବାକ୍ୟରେ "ଯେ" ଶବ୍ଦଟି  କେଉଁ  ପ୍ର କାରର ଅବ୍ୟୟ ?

A.  ସମ୍ମତି ସୂ ଚକ ଅବ୍ୟୟ

B.  ବି ସ୍ମୟସୂ ଚକ ଅବ୍ୟୟ

C.  ବି କଳ୍ପାର୍ଥ କ ଅବ୍ୟୟ

D.  ଆଳଙ୍କାରି କ ଅବ୍ୟୟ

✓

Q71 Odia
ତତ୍ସମ ଶବ୍ଦଟି କୁ  ଚି ହ୍ନି ତ କର ?

A.  ଦହି

B.  ଥନ

C.  ଉକୁ ଣି

D.  ନଦୀ

✓

Q72 Odia
"ମାଆ ଶି ଶୁ କୁ  ଚାନ୍ଦ ଦେଖାଉଛନ୍ତି " - ଏହି  ବାକ୍ୟରେ 'ଦେଖାଉଛନ୍ତି ' କେଉଁ  ପ୍ର କାର କ୍ରି  ୟା?

A.  ମୌଳି କ କ୍ରି  ୟା

B.  ପ୍ରେ ରଣାର୍ଥ କ କ୍ରି  ୟା

C.  ନାମଧାତୁ  କ୍ରି  ୟା

D.  ଅକର୍ମ କ କ୍ରି  ୟା
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✓

Q73 Odia
"ତାଙ୍କର 'ଆବି ର୍ଭା ବ' ଯେତି କି  ଆଶ୍ଚର୍ଯ୍ୟ ଜନକ ଥି ଲା, '________' ସେତି କି  ଦୁଃ ଖଦାୟକ ଥି ଲା।"
(ନି ମ୍ନ ରେ ପ୍ର ଦତ୍ତ ଶବ୍ଦ ମଧ୍ୟରୁ  ସଠି କ ଶବ୍ଦ ବ୍ୟବହାର କରି  ଶୂ ନ୍ୟସ୍ଥାନ ପୂ ରଣ କର)

A.  ପ୍ର ସ୍ଥାନ

B.  ତି ରୋଧାନ

C.  ବି ଦାୟ

D.  ବି ଲୟ

✓

Q74 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  'ବି ଯୋଜକ ଅବ୍ୟୟ' କି ଏ ?

A.  ଏବଂ

B.  କି ମ୍ବା

C.  କାରଣ

D.  ତେଣୁ

✓

Q75 Odia
"ଧୀରପାଣି  ପଥର କାଟେ"- ଏହି  ଲୋକୋକ୍ତି ର ଠି କ୍  ଅର୍ଥ  କି ଏ ?

A.  ତୁ ରନ୍ତ କାମ କରି ବା ଉଚି ତ

B.  କି ଛି  କାମ କରି ବା ଆବଶ୍ୟକ ନାହିଁ

C.  ଧୀର ସ୍ଥି ର ଭାବେ କାର୍ଯ୍ୟ  କଲେ ସଫଳତା ମି ଳେ

D.  ଭୟ କରି ବା ଉଚି ତ ନୁ ହେଁ

Computer

✓

Q76 Computer
What is the first step in creating a new document in MS Word?

A.  Select File → Open

B.  Select File → New

C.  Press Ctrl + S

D.  Click Insert → New Page

✓

Q77 Computer
Which option allows setting uniform margins for a document in MS
Word 2021?

A.  Page Number

B.  Paragraph

C.  Margins

D.  Header

✓

Q78 Computer
ପାୱାରପଏଣ୍ଟର କେଉଁ  ଟ୍ୟାବ ଆପଣଙ୍କୁ  ସ୍ଲା ଇଡ ପ୍ରେ ଜେଣ୍ଟ କରି ବା ପାଇଁ  ସେଟଅପ ବାଛି ବାକୁ
ଅନୁ ମତି  ଦି ଏ?

A.  Home

B.  Insert

C.  Slide Show

D.  View

✓

Q79 Computer
ଏକ ଡି ଟେଲ ସେଲ୍ସ  ଲେଜର ଡି ଜାଇନ କରି ବା ସମୟରେ, ନେହା ଗ୍ରା ହକଙ୍କର ଦୀର୍ଘ  ରି ମାର୍କ କୁ
ଆକୋମୋଡେଟ କରି ବା ପାଇଁ  କଲମ B ର ୱି ଡଥକୁ  ବୃ ଦ୍ଧି  କରନ୍ତି  । କଲମ ବାଉଣ୍ଡାରି
ବାରମ୍ବାର ଡ୍ରା ଗ ସତ୍ତ୍ୱେ, MS ଏକ୍ସେଲ ଫରଦର ରି ସାଇଜ କରି ବା ବନ୍ଦ କରି ଦେଇଥାଏ । ସେ
ଏହାର ସମ୍ମୁଖୀନ ହୁ ଅନ୍ତି  କାରଣ ଏକ୍ସେଲ କଲମର ସର୍ବା ଧି କ ୱି ଡଥକୁ  ___________ ପାଇଁ
ସ୍ଥି ର କରି ଥାଏ ।

A.  255ଟି  କ୍ୟାରେକ୍ଟର

B.  512ଟି  କ୍ୟାରେକ୍ଟର

C.  1024 ପି କ୍ସେଲ

D.  300 ପଏଣ୍ଟ
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✓

Q80 Computer
Which type of computer memory is volatile, meaning it loses all its
stored data as soon as the computer's power is turned off?

A.  Read-Only Memory (ROM)

B.  Random Access Memory (RAM)

C.  Hard Disk Drive (HDD)

D.  Solid State Drive (SSD)

✓

Q81 Computer
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ ଟି କୁ  ପଏଣ୍ଟିଂ  ଇନପୁ ଟ ଡି ଭାଇସ ଭାବରେ ବର୍ଗୀ କୃ ତ କରାଯାଇଛି ?

A.  ପ୍ଲ ଟର

B.  ଟ୍ରା କବଲ

C.  ସ୍ପି କର

D.  ଇଙ୍କଜେଟ ପ୍ରି  ଣ୍ଟର

✓

Q82 Computer
ଏକ ବ୍ଳା ଙ୍କ ୱାର୍କ ସି ଟ ରେ ଫର୍ମୁ ଲା =TODAY () ଏଣ୍ଟର କଲେ କଣ ରି ଟର୍ନ  ମି ଳି ବ?

A.  ଶବ୍ଦ 'Today'

B.  ବର୍ତ୍ତ ମାନର ସମୟ (current time)

C.  ମାସଟି ର ମୋଟ ଦି ନ ସଂଖ୍ୟା

D.  ସି ଷ୍ଟମ କ୍ଳକ ଅନୁ ସାରେ କରେଣ୍ଟ ଡେଟ

✓

Q83 Computer
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  କମ୍ବି ନେସନରେ ଡି ଭାଇସଗୁ ଡ଼ି କ, ସେମାନଙ୍କ ବର୍ଗ  (categories) ସହ
ସଠି କ ଭାବରେ ମେଳ ଖାଉଛନ୍ତି  ?

A.  ମାଉସ - ଆଉଟପୁ ଟ, ପ୍ରି  ଣ୍ଟର - ଇନପୁ ଟ

B.  ମନି ଟର - ଇନପୁ ଟ, ମାଇକ୍ରୋ ଫୋନ - ଆଉଟପୁ ଟ

C.  କୀବୋର୍ଡ  - ଇନପୁ ଟ, ସ୍ପି କର - ଆଉଟପୁ ଟ

D.  ସ୍କାନର - ଆଉଟପୁ ଟ, ବ୍ରେ ଲ (Braille) କୀବୋର୍ଡ  - ଆଉଟପୁ ଟ

✓

Q84 Computer
What does PCB stand for in a computer?

A.  Printed Circuit Board

B.  Peripheral Component Board

C.  Primary Control Board

D.  Programmed Chip Base

✓

Q85 Computer
Which of the following is a feature of LAN?

A.  Covers a city

B.  Covers the entire globe

C.  Covers a small geographical area

D.  Requires satellite

✓

Q86 Computer
Where can you enter text for a slide other than directly in the
placeholder on the Slide Pane?

A.  In the Transition Pane

B.  In the Notes Pane

C.  In the Outline tab of the Overview Pane

D.  In the Header and Footer Dialog

✓

Q87 Computer
What is the purpose of 'Slide Transition'?

A.  To add audio

B.  To animate text

C.  To change from one slide to another with effects

D.  To format text

✓

Q88 Computer
ଯଦି  ଆପଣଙ୍କ ଫାଇଲ 25 MB ରୁ  ଅଧି କ ହୁ ଏ, ତେବେ ଜି ମେଲ ଏହାକୁ  ଏକ ଆଟାଚମେଣ୍ଟ
ଭାବରେ ରଖି ବା ପରି ବର୍ତ୍ତେ  ଆପେ ଆପେ ଇମେଲରେ ଏକ __________ ଆଡ କରି ଥାଏ ।

A.  ଲି ଙ୍କ

B.  ଆଟାଚମେଣ୍ଟ ଲି ଙ୍କ

C.  ଗୁ ଗୁ ଲ ଡ୍ରା ଇଭ ଲି ଙ୍କ

D.  ଲୋକାଲ ଡ୍ରା ଇଭ ଲି ଙ୍କ
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✓

Q89 Computer
ଏକାଧି କ MS ଏକ୍ସେଲ ୱାର୍କ ବୁ କ କୁ  ଏକାସାଙ୍ଗରେ ପ୍ରି  ଣ୍ଟ କରି ବା ପାଇଁ  ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ସର୍ତ୍ତ
ପୂ ରଣ ହେବା ଆବଶ୍ୟକ?

A.  ସମସ୍ତ ଫାଇଲ କୁ  ପ୍ର ଥମେ PDF ଡକ୍ୟୁ ମେଣ୍ଟ ଭାବରେ ସେଭ କରି ବାକୁ  ପଡି ବ ।

B.  ୱାର୍କ ବୁ କ କୁ  ଭି ନ୍ନ ଭି ନ୍ନ ଫୋଲ୍ଡ ରରେ ସେଭ କରି ବାକୁ  ହେବ ।

C.  ସମସ୍ତ ୱାର୍କ ବୁ କ କୁ  ସମାନ ଫୋଲ୍ଡ ରରେ ଷ୍ଟୋର କରି ବାକୁ  ହେବ ।

D.  ପ୍ର ତ୍ୟେକ ୱାର୍କ ବୁ କ କୁ  ଏକ ପୃ ଥକ ଏକ୍ସେଲ ୱି ଣ୍ଡୋରେ ଓପନ କରି ବାକୁ  ହେବ ।

✓

Q90 Computer
MS ୱାର୍ଡ ରେ Layout ଟ୍ୟାବର କେଉଁ  ଗୃ ପରେ ମାର୍ଜିନ, ପେଜ ଓରି ଏଣ୍ଟେସନ ଏବଂ
ପେପର ସାଇଜ ଭଳି  ସେଟି ଙ୍ଗସ ଆଡଜଷ୍ଟ କରି ବା ପାଇଁ  ଅପ୍ସନ ରହି ଛି ?

A.  Paragraph

B.  Page Setup

C.  Styles

D.  Font

Reasoning

✓

Q91 Reasoning
G H ଙ୍କ ମାଆ ଅଟନ୍ତି  । H J ଙ୍କ ସ୍ୱାମୀ ଅଟନ୍ତି  । J K ଙ୍କ ଭଉଣୀ ଅଟନ୍ତି  । L K ଙ୍କ ବାପା ଅଟନ୍ତି  । G
ସମ୍ପର୍କ ରେ L ଙ୍କର କ'ଣ ହେବେ?

A.  ଝି ଅର ମାଆ 

B.  ଝି ଅର ସ୍ୱାମୀଙ୍କ ମାଆ

C.  ଝି ଅର ସ୍ୱାମୀଙ୍କ ଭଉଣୀ

D.  ଝି ଅର ଝି ଅ

✓

Q92 Reasoning
Q, W, E, R, T, Y ଏବଂ U ଏକ ବୃ ତ୍ତାକାର ଟେବୁ ଲ ଚାରି ପଟେ କେନ୍ଦ୍ରକୁ  ମୁ ହଁ  କରି  ବସି ଛନ୍ତି  ।
R ହେଉଛି  T ଏବଂ Y ର ନି କଟତମ ପଡ଼ୋଶୀ । T ର ଠି କ ଡାହାଣ ପଟେ E ବସି ଛି  । E ଏବଂ
W ର ନି କଟତମ ପଡ଼ୋଶୀ U ନୁ ହେଁ  ।ନି ମ୍ନ ଲି ଖି ତମାନଙ୍କ ମଧ୍ୟରୁ  କି ଏ U ର ନି କଟତମ
ପଡ଼ୋଶୀ ଅଟନ୍ତି ?

A.  R ଏବଂ Y

B.  Q ଏବଂ Y

C.  E ଏବଂ R

D.  T ଏବଂ Y

✓

Q93 Reasoning
S, T, U, V, M, N ଏବଂ O ପ୍ର ତ୍ୟେକଙ୍କର ପରୀକ୍ଷା ସପ୍ତାହର ଏକ ଭି ନ୍ନ ଦି ନରେ ଅଛି , ଯାହା
ସେହି  ସପ୍ତାହର ସୋମବାର ଠାରୁ  ଆରମ୍ଭ ହୋଇ ରବି ବାର ଦି ନ ଶେଷ ହୁ ଏ । ଶୁ କ୍ର ବାର ଦି ନ S
ର ପରୀକ୍ଷା ଅଛି  । N ଏବଂ S ମଧ୍ୟରେ କେବଳ ଦୁ ଇ ଜଣଙ୍କର ପରୀକ୍ଷା ଅଛି  । U ଏବଂ N
ମଧ୍ୟରେ କେବଳ ଚାରି ଜଣଙ୍କର ପରୀକ୍ଷା ଅଛି  । T ର ଠି କ ପରଦି ନ O ର ପରୀକ୍ଷା ଅଛି  ।
ସୋମବାର ଦି ନ M ର ପରୀକ୍ଷା ନାହିଁ ।
M ଏବଂ V ମଧ୍ୟରେ କେତେ ଜଣଙ୍କର ପରୀକ୍ଷା ଅଛି ?

A.  ଏକ

B.  ଦୁ ଇ

C.  ତି ନି

D.  ଚାରି

✓

Q94 Reasoning
ଯଦି  ସଂଖ୍ୟା 7438156 ର ପ୍ର ତ୍ୟେକ ଅଯୁ ଗ୍ମ  ଅଙ୍କରେ 1 ଯୋଗ କରାଯାଏ ଏବଂ ପ୍ର ତ୍ୟେକ
ଯୁ ଗ୍ମ  ଅଙ୍କରୁ  2 ବି ୟୋଗ କରାଯାଏ, ତେବେ ବାମରୁ  ଦ୍ଵି ତୀୟରେ ଥି ବା ଅଙ୍କ ଏବଂ ଡାହାଣରୁ
ଦ୍ଵି ତୀୟରେ ଥି ବା ଅଙ୍କର ସମଷ୍ଟି  କେତେ?

A.  8

B.  10

C.  14

D.  12

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q95 Reasoning
TT 14 is related to WX 25 in a certain way. In the same way, QE 17 is
related to TI 28. To which of the following is VN 27 related, following
the same logic?

A.  UH 78

B.  HY 76

C.  HG 65

D.  YR 38

✓

Q96 Reasoning
ପ୍ର ଦତ୍ତ ଅନୁ କ୍ର ମକୁ  ତର୍କ ସି ଦ୍ଧ ଭାବେ ସଂପୂ ର୍ଣ୍ଣ  କରି ବା ପାଇଁ  ନି ମ୍ନ  ଲି ଖି ତ ଅକ୍ଷର-ସଂଖ୍ୟା ପୁ ଞ୍ଜ
ମଧ୍ୟରୁ  କେଉଁ ଟି କୁ  ପ୍ର ଶ୍ନ ଚି ହ୍ନ (?) ସ୍ଥାନରେ ସ୍ଥାପି ତ କରାଯାଇପାରି ବ?

MVK 1 NSI -2 OPG 4 PME -8 ?

A.  QJC 16

B.  PME -8

C.  BHG -9

D.  NHT -2

✓

Q97 Reasoning
କାର୍ତିକ ପଏଣ୍ଟ A ରୁ  ବାହାରି  ଉତ୍ତର ଦି ଗକୁ  10 km ଗାଡି  ଚାଳନା କରନ୍ତି  । ତାପରେ ସେ
ବାମ ମୋଡ଼ ନେଇ, 8 km ଗାଡି  ଚାଳନା କରନ୍ତି , ବାମ ମୋଡ଼ ନେଇ 14 km ଗାଡି  ଚାଳନା
କରନ୍ତି  । ତାପରେ ସେ ବାମ ମୋଡ଼ ନେଇ 12 km ଗାଡି  ଚାଳନା କରନ୍ତି  । ସେ ଶେଷ ବାମ
ମୋଡ଼ ନେଇ, 4 km ଗାଡି  ଚାଳନା କରନ୍ତି  ଏବଂ ପଏଣ୍ଟ P ରେ ଅଟକି ଯାଆନ୍ତି  । ପୁ ନର୍ବା ର
ପଏଣ୍ଟ A ରେ ପହଞ୍ଚି ବା ପାଇଁ  ସେ କେତେ ଦୂ ର (ସର୍ବ ନି ମ୍ନ  ଦୂ ରତା) ଏବଂ କେଉଁ  ଦି ଗକୁ  ଗାଡି
ଚଲାଇବା ଉଚି ତ? (ପ୍ର ଦତ୍ତ ନଥି ଲେ ସମସ୍ତ ମୋଡ଼ କେବଳ 90-ଡି ଗ୍ରୀ  ମୋଡ଼ ଅଟେ ।)

A.  4 km ପଶ୍ଚି ମ

B.  4 km ପୂ ର୍ବ

C.  5 km ପଶ୍ଚି ମ

D.  5 km ପୂ ର୍ବ

✓

Q98 Reasoning
ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମ ଆଧାରରେ ନି ମ୍ନ ଲି ଖି ତ ଚାରୋଟି  ମଧ୍ୟରୁ  ତି ନୋଟି  ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ
ଉପାୟରେ ସଦୃ ଶ ଅଟନ୍ତି  ତେଣୁ  ଏହି ପରି  ଏକ ଗୋଷ୍ଠୀ ଗଠନ କରନ୍ତି  । କେଉଁ ଟି  ସେହି
ଗୋଷ୍ଠୀର ଅନ୍ତର୍ଭୁ କ୍ତ ନୁ ହେଁ ?
(ଦ୍ର ଷ୍ଟବ୍ୟ: ଅସାମଞ୍ଜସ୍ୟଟି  ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ /ସ୍ୱରବର୍ଣ୍ଣ  ସଂଖ୍ୟା କି ମ୍ବା ଅକ୍ଷର ପୁ ଞ୍ଜରେ ସେମାନଙ୍କର
ସ୍ଥି ତି  ଉପରେ ଆଧାରି ତ ନୁ ହେଁ )

A.  EFA

B.  QPM

C.  XWT

D.  CBY

✓

Q99 Reasoning
ପ୍ର ଦତ୍ତ ବି ବୃ ତି  ଓ ନି ଷ୍କର୍ଷ ଗୁ ଡି କୁ  ଧ୍ୟାନର ସହି ତ ଅଧୟନ କରନ୍ତୁ । ଏହା ସାଧାରଣତଃ
ଜଣାଶୁ ଣା ତଥ୍ୟ ଠାରୁ  ଭି ନ୍ନ ମନେହେଲେ ସୁ ଦ୍ଧା ବି ବୃ ତି ରେ ପ୍ର ଦତ୍ତ ତଥ୍ୟ କୁ  ସତ୍ୟ ବୋଲି
ବି ବେଚନା କରନ୍ତୁ ଏବଂ ପ୍ର ଦତ୍ତ ବି ବୃ ତି  (ଗୁ ଡି କୁ ) କୁ  ତର୍କ ସଙ୍ଗତ ଭାବରେ କେଉଁ  ନି ଷ୍କର୍ଷ
(ଗୁ ଡି କ) ଅନୁ ସରଣ କରୁ ଛି  ତାହା ନି ର୍ଣ୍ଣ ୟ କରନ୍ତୁ ।

ବି ବୃ ତି : ସମସ୍ତ ଫୁ ଲଦାନୀ ଚାମଚ ଅଟେ । କୌଣସି  ଚାମଚ ଗୋଲାପ ନୁ ହେଁ  ।

ନି ଷ୍କର୍ଷ  I: କୌଣସି  ଗୋଲାପ ଫୁ ଲଦାନୀ ନୁ ହେଁ  ।
ନି ଷ୍କର୍ଷ  II: କି ଛି  ଗୋଲାପ ଫୁ ଲଦାନୀ ଅଟେ ।

A.  କେବଳ ନି ଷ୍କର୍ଷ  (I) ଅନୁ ସରଣ କରେ

B.  କେବଳ ନି ଷ୍କର୍ଷ  (II) ଅନୁ ସରଣ କରେ 

C.  ନି ଷ୍କର୍ଷ  (I) କି ମ୍ବା (II) କୌଣସି ଟି  ଅନୁ ସରଣ କରେ ନାହିଁ 

D.  ଉଭୟ ନି ଷ୍କର୍ଷ  (I) ଏବଂ (II) ଅନୁ ସରଣ କରେ 

✓

Q100 Reasoning
ଶବ୍ଦ COLLEGE ର ପ୍ର ତ୍ୟେକ ସ୍ୱରବର୍ଣ୍ଣ କୁ  ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମରେ ଏହାର ଠି କ
ପରବର୍ତ୍ତୀ  ଅକ୍ଷରରେ ପରି ବର୍ତ୍ତ ନ କରାଯାଏ ଏବଂ ପ୍ର ତ୍ୟେକ ବ୍ୟଞ୍ଜନ ବର୍ଣ୍ଣ କୁ  ଇଂରାଜୀ
ବର୍ଣ୍ଣ ମାଳା କ୍ର ମରେ ଏହାର ଠି କ ପୂ ର୍ବ ବର୍ତ୍ତୀ  ଅକ୍ଷରରେ ପରି ବର୍ତ୍ତ ନ କରାଯାଏ । ଏହି ପରି  ଗଠି ତ
ନୂ ତନ ଅକ୍ଷର ଗୋଷ୍ଠୀରେ ନି ମ୍ନ ଲି ଖି ତ ଅକ୍ଷରଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  କେଉଁ ଟି  ବାମ ପାର୍ଶ୍ୱ ରୁ  ତୃ ତୀୟ
ହେବ?

A.  K

B.  F

C.  P

D.  B
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